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OVERVIEW

About data sources

MetScape is a plug-in for Cytoscape, the bioinformatics network visualization tool.
The plug-in can be used to visualize and interpret metabolomic data in the context of
human metabolic networks.

MetScape provides a metabolite database developed by extracting and integrating
information from the following sources:

e NCIBI HUMDB Database—http://portal.ncibi.org/gateway/tryourtools.html

e Edinburgh Human Metabolic Network (EHMN)—
http://www.ehmn.bioinformatics.ed.ac.uk/

¢ KEGG COMPOUND Database—http://www.genome.jp/kegg/compound/

Workflow overview
With MetScape, you can:
e Trace the connections between metabolites and genes.

e Visualize compound networks and display compound structures, as well as
information for reactions, enzymes, genes, and pathways.

o Upload experimental data to visualize and explore compound networks over time
or in varying experimental conditions.

The basic steps in the workflow include:

1. Enter data. You can type or paste a list of compounds, upload a file of containing
experimental data, or start from a biological pathway.

2. Select compound and reaction attributes. Choose which attributes to display in a
table as you work with a visual network graph.

3. Explore the visual network and table of attributes:

e Expand and collapse a network.

e Create a subnetwork.

e Sort and filter data, including the filtering of reactions by pathway.

e Visualize your data in a wide variety of network layouts provided by
Cytoscape.

e Use color, size, and other effects to visually reflect a set of attribute values.
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4.

5.

Display additional information not included as compound or reaction attributes.

Save your session and reopen it later.

INSTALLING CYTOSCAPE AND THE METSCAPE PLUGIN

You can use the MetScape plugin for Cytoscape in one of two ways:

By launching Cytoscape and the MetScape plugin from MiMIl Web. With
this method, you launch a temporary copy of Cytoscape and the MetScape plugin
from a Compound Details page after performing a search on MiMI Web. Use this
method when you don’t have the administrative privileges to install software on
your computer. You will not have access to other plugins when you use this
method.

By installing Cytoscape and the MetScape plugin on your local computer.
With this method, you can use other plugins that work with MetScape data, such
as Shortest Path and MCODE.

Launching Cytoscape and the MetScape plugin from the Web

To launch Cytoscape and the MetScape plugin from MiMI Web:

1.
2.

N o o kWw

Go to http://mimi.ncibi.org/MimiWeb/upload-page.jsp.

Click the Browse button and select a text file containing compound IDs, one per
line.

Click the Copy to Text Box button.
For Select type, choose Cids.
Click the MiMI Search button.
Click a compound ID link.

On the Compound Details page, click the View in Metscape link.

After launching the Web version, you can do anything described in this User Guide.

You can save your Cytoscape session on your local computer and reopen it at a later
time after launching the application from MiMI Web again.
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Installing Cytoscape and the MetScape plugin on your local

computer

1. Install Cytoscape on your computer. For more information, go to:

e The Cytoscape website at http://cytoscape.org/.

or

e The NCIBI Virtual Workshop page at http://portal.ncibi.org/gateway/virtual-

workshop.html.

2. After Cytoscape is installed, start the application.

3. To install the MetScape plugin, select Plugins - Manage Plugins from the

Cytoscape menu.

4. Under Available for Install, click the + box to expand the Network and

Attribute 170 group.

(& ] Manage Plugins

=)

available For download Fron

Cytoscape

|| Show outdatad Plugins

Currently Installed: 20
#- 4y Theme: 1
-4 Core: 14
[~ }. Network and Attribute IfO: 4
I Uncategorized: 1

Available for Install: 121
+ Theme: 1
¥ Analysis:
unication/Scripting: 6

< A‘Q Network and Attribute 1/O: 35
- Other: 18

(- . Network Inference: 7
& Functional Enrichment: 13

and

Click to expand the Network
Attribute I/O group

Close |
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5. Find and click the most recent version of the MetScape plugin.

(] Manage Plugins | =

Plugins available for download From:

Cytoscape [ Change Download Site ]

[7] show outdated Plugins

B Lol o [ [ e e

<nd GPML-Plugini v.0.7 MetScape i
wnf GPML-Plugin v.0.8
onf GPML-Plugin v.0.9 Version: 1.01
wenf GPML-Plugin v.1.0
“f INEACEWSClient v.0.66 Category: MNetwork and Attribute 1/O
wof MetScape v.0.8

of MetScape v, 1.0 Descr‘iptil:ll‘l:

e lMetScape v, 1,01 N
S ||| MetScape provides a bioinformatics framewarle

e MiMIplugin v.3.0 : i : )
¢ MMIplugin v.3.01 = [ | for the visualization and interpretation of

»

m

ond NCBICliENt v.0.7 metabolomic data. Metabolomic data from
- NCBIEntrezGeneUserInterface v.0.5:L || | HUMDE, EHMI and KEGG is integrated and
~-~f PICRClient v.0.2 stored in a database at NCIBIL MletScape allows

-f SessionForweb v.3.1

f SessionForweb v.3.2 T
4 | 1 | »

users to trace the connections between
metabolites and genes. MetScape allows users to

Messages:

[ Install ] [ Close ]

e "

6. Click Install.

7. When installation is complete, click Close.

A MetScape option is added to the Cytoscape Plugins menu.

ENTERING DATA
1. To begin a Cytoscape session with the MetScape plugin, first start Cytoscape.
2. Select Plugins > MetScape - Build Network from the Cytoscape menu.

3. Choose one of the following methods to get started.
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Option 1: Enter a list of compounds
Use to explore a network of compounds and reactions, starting from a list of
compounds.

1. Click the Enter Compound(s) tab.
|£| Welcome to MetScape 1.01 E@ﬁj

Enter Compound(s) | Load Experiment: File I Shaw Pathway|
Query Metabolic Database

Enter compounds, one per Line. Then dlick "search” button.

Input Type: .Compound Names w | Compound Lookup

(@ Show Reactions as Nodes (CR) () Show Reactions as Edges (CO)

{You can switch CR <=2 CO at anytime via node context menu (right click on a node to pop up the menu) after creating a netwark)

- 4

2. To identify compounds, you can enter compound names or KEGG compound IDs.
To enter KEGG IDs, select KEGG IDs from the Input Type dropdown:

r b
|£| Welcome to MetScape 1.01 E@ﬁ

Enter Compound(s) | Load Experiment File I Show Pathwav|
Query Metabolic Database

Enter compounds, one per Line. Then dlick "search” button.

Input Type: J-'_C_cln_'lpound_ Mames 7,1. Compound Lookup
= (Compound Mames
@ Show ReactioMShow Reactions as Edges (CO)
{You can switch CR <=> CO at anytime via node context menu (right dick on a node to pop up the menu) after creating a netwark)
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3. In the text box, enter or paste compound names or KEGG IDs, each on its own

line.
Examples:

Compound names KEGG compound IDs
glutathicone Cooosl
glucose Co0293
fructose C0l49&
creatinine Coo79l
d-mannoae C0015%9
adencsine cooz212
taurine Co0245
myo—-inositol Coo0137
inogine Con294
beta-alanine Cooo9g
urate Co0366
nicotinamide C00153

If you need to look up a compound name or ID, click Compound Lookup. On
the resulting NCIBI compound lookup page, use your browser’s Find (Ctrl-F)
command to enter the name or ID to find the row that contains both.

Compound

Compound
ID

[CE5935  |synomym  [((25).(6R).10)-trimethyhindecanoyl-CoA

[CE5935  [synomym  [((25).(6R).10)-trimethyhindecanoyl-CoA sym (2S.6R. 10)-trimethyhndecanoyl-CoA
|m |synon}'m |(—)—5—(3'=4'=5 "-trihydroxyphenyl)-gama-valerolactone

CE3134 |(—)—5—(3=4=5—h'ﬂ1}'droxypheny1)— gama-valerolactone

|m |pr'rman.'_name |(—)—5—(3=4=5—n'i11}'dr0x3_.'phm§_.'1)— gama-valerolactone

|M |synon}'m |(—)—5—(3Aj—ﬁ'ill}'droxyphen}'l)— gama-valerolactone sulfate

|m |synon}'m |(—)— delta-(3',4'.5' -trihydroxyphenyl)- gama-valerolactone

|m |synon}'m |(—)— delta-(3,4,5-trihydroxyphenyl)- gama-valerolactone

Name Type Compound Name

CE3811 |(—)— delta-(3',4',5"-trihydroxyphenyl)-gama-valerolactone 3'.4',5'-trisulfate
|w |pr'rman'_name |(-)- delta-(3',4',5'-trhydroxyphenyl)-gama-valerolactone 3'.4',5'-trisulfate
CE3809 |(—)— delta-(3',4',5"-trihydroxyphenyl)-gama-valerolactone 3'.4'-disulfate
|m |priruar}’_name |(—)— delta-(3',4'. 5" -trihydroxyphenyl)- gama-valerolactone 3',4'-disulfate
(CE3E10 |(—)— delta-(3',4'.5' -trihydroxyphenyl)- gama-valerolactone 3',5'-disulfate
|M |pr'rman.'_name |(—)— delta-(3',4',5"-trihydroxyphenyl)-gama-valerolactone 3',5'-disulfate
CE3126 |(—)— delta-(3',4',5"-trihydroxyphenyl)-gama-valerolactone 3'-sulfate

520260 adesimampmened)- a3 4 8L tribydemnbenydese s saleraictone 2sulfatast st 8 ol

4. Select a network style by selecting either Show Reactions as Nodes or Show
Reactions as Edges.
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With Show Reactions as Nodes, the network will consist of the queried
compounds, reactions in which they participate, and any other compounds
involved in those reactions, all shown as nodes.

With Show Reactions as Edges, the network will consist of the queried
compounds and the nearest-neighbor compounds shown as nodes, and the
reactions they share shown as edges.

Examples of resulting networks:

Reactions as edges,

Reactions and compounds as compounds as nodes:
nodes:
A s e
(‘ (Y ‘

| A

- e
RP3167
jdl\‘
4 ’ 4 ~

B R oA .

r oxidireq tathione
oo

oxidlzwone

5. Click Search to query the metabolic database and create the network.

Option 2: Load an experiment file

Use to upload experimental data to visualize and explore compound networks over
time or in varying experimental conditions.

The data file must meet the following requirements:
e The data should be normalized.
e The file must be a text file with:
— Columns separated by tabs.
— Rows separated by new lines (each row on its own line).
e The first row must be a heading row, in which:
— The first column indicates the number of parameters.

— The remaining columns in the first row are column headings to label the data,
one set of column headings for each parameter.
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e All other rows contain experimental data, in which:
— The first column contains a KEGG compound ID.

— The remaining columns contain data, one set of data values for each
parameter.

Example:

(Number of parameters)

(Column headings for parameter l) (Column headings for parameter 2

N — Y

2 Ben_fe - MetasVsLoc_fc  Benigr Localized Metastatic
C00051 0.534142987 0.188065091 43.70067462 23.34240888 4.389892238

c00293 1 0.542945858 1.000738537 44.42450968 24.1201035 24.1379171
Cc014% 1 0.603480364 0.730487808 2.587604327 1.561568402 1. 06679
c00791 1 0.675296736 1.07307884 5.818712146 3.920357438 4.216510322

cools39 1 0.700759624 0.867985269 3.61648812¢6 2.53428886 2. 75074

Data < cooz1z 1 0.778355692 0.633015584 2.456702154 1.912188104 1.21044487
c0g245 1 0.780538856 0.720061035 2.138862965 1.66%465652 1.203619684

1 0 0.36101872¢ 237.5752764 85.76936115

1 0.32323576& 15. 1693 4. 025

L J U J

Y Y

(KEGG |DS) (Data for parameter l) (Data for parameter 2)

In this example, the column headings are:

e Ben_fc: Benign fold change

e LocVsBen_fc: Localized vs. benign fold change

e MetasVsLoc_fc: Metastatic vs. localized fold change
e Benign: Concentration

e Localized: Concentration

e Metastatic: Concentration

1. Click the Load Experiment File tab.
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| £| Welcome to MetScape 1.01 =HREN X

| Enter Compound(s) | Load Experiment F||E| show Pathway

Query Metabolic Database

[ Load Expetiment Filz... H Help ]

2. Click the Load Experiment File... button.

3. Navigate to the text file containing experiment data and click Open. The Scaling
Options dialog appears:

|£| Welcome to MetScape 1.01 =HECIH X

Scaling Options

(7 Bcale input datarange to (0,107 () Ln(natural logarithm) input data @) Criginal data

{Using Log OR. Rescaling input data ko get better visualization result if data is nok normally distributed)

Metwork Style Options

(@ Show Reactions as Nodes (CR) () Show Reactions as Edges (CO)

Stark

4. Optionally, select a scaling option, which may improve the visual representation
of changes in data:

e Scale input data range to (0,10). Use this scaling method when the range
of the input data is large or not normally distributed.

¢ Ln(natural logarithm) input data. Use this method when the range of the
input data is large.

e Original data. Use this method to use original data with no scaling.

5. Select a network style by selecting either Show Reactions as Nodes (CR) or
Show Reactions as Edges (CO).

With Show Reactions as Nodes (CR), the network will consist of the queried
compounds, reactions in which they participate, and any other compounds
involved in those reactions, all shown as nodes.
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With Show Reactions as Edges (CO), the network will consist of the queried
compounds and the nearest-neighbor compounds shown as nodes, and the

reactions they share shown as edges.

Examples of resulting networks:

Reactions and compounds as
nodes:

R’f
"
4 _r

D

shoogs
nxidizwone

Reactions as edges,
compounds as nodes:

A R S
1

&
[=]
!4'\‘
ys-ghy
oxidthione

6. Click Start to query the metabolomics database and create the network.

To work with your experiment data, see “Visualizing Changes in Experimental Data.”

Option 3: Select a pathway

Use to view all the compounds and reactions associated with a metabolic pathway.

1.

Click the Show Pathway tab.

P

|£| Welcome to MetScape 1.02

| Enter Compound(s) I Load Experiment File || Show Pathway |

Query Metabolic Database

:TCA cyde

() Show Reactions as Modes (CR)

(@ Main Compounds

- Draw Pathway

(@ Show Reactions as Edges (CO)

() All Compounds

Metscape Plugin User Guide -
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2. Select a specific pathway from the drop-down list, or select All at the top of the
list.

| 5[ Welcome to MetScape 1.01 5

| Enter Compound(s) I Load Expetiment Filz | Show Pathway

Query Metabolic Database

I-\ﬂtamin A (retinol} metabolism - | Draw Pathway

)

Tryptophan metabalism

Tyrosine metabolism

Urea cycle and metabolism of arginine, proline, glutamate, aspartate and asparagine
Valine, leucine and iscleucine degradation

Vitamin B1 (thiamin) metabalism k =

Vitamin B12 (cyanacobalamin metsbalism
Vitamin B2 (riboflavin) mekabolism

-

3. Select a network style by selecting either Show Reactions as Nodes or Show
Reactions as Edges.

With Show Reactions as Nodes, the network will consist of the queried
compounds, reactions in which they participate, and any other compounds
involved in those reactions, all shown as nodes.

With Show Reactions as Edges, the network will consist of the queried
compounds and the nearest-neighbor compounds shown as nodes, and the
reactions they share shown as edges.

Examples of resulting networks:

Reactions as edges,
Reactions and compounds as compounds as nodes:

nodes:
" » v
Ii e
A ‘

v
e ®
RDO1{5
- e@r
1 oxid thione

4

I ; 14 y
shoods
uxidizione

4. Click Draw Pathway to create the network.

A
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CHOOSING ATTRIBUTES FOR DISPLAY IN THE DATA
PANEL

Attributes of compounds and reactions you have selected in the network appear in
the Cytoscape Data Panel.

Choosing attributes provided through MetScape

To choose which attributes to view:

1. To choose attributes for compounds, click the Node Attribute Browser tab in
the Data Panel. Choose attributes for reactions based on the network style:

e If the style is Show Reactions as Nodes, click the Node Attribute Browser
tab.

e If the style is Show Reactions as Edges, click the Edge Attribute Browser
tab.

2. Click the Select Attributes icon in the Data Panel toolbar.

| Data Panel

HOE
(Select Attributes —IE—J

Node Attribute Browser | Edge Attribute Browser

3. Select the attributes you want displayed in the Data Panel.

Data Panel

w12
=5

1 [

Description
Enzyme
Formula

] Mas
NodeLabel
;Pathway

] Reversibilit

M

m

Notes:

¢ When both compounds and reactions are shown as nodes, you can use the

Type attribute on the Node Attribute Browser tab to distinguish between
them.
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e Some attributes (such as Formula, Mass, and Smile) apply only to compound
nodes, while others (such as Enzyme, Pathway, and Reversibility) apply only
to reaction nodes.

e Switching from one network style to another using Show Reactions as
Nodes or Show Reactions as Edges may leave behind reaction attribute
columns on either the Node Attribute Browser or Edge Attribute Browser
tab.

e Other plugins used earlier in your Cytoscape session may leave behind
attributes that don’t apply to MetScape compound or reaction data.

4. When you are done, click anywhere outside the list.

5. Select compounds and/or reactions to view their attributes in the Data Panel (see
“Selecting Compounds and Reactions”).

e

“Rpisgs
N

\ Eni

Data Panel

=

Type Description Formula

R0O5196 Reaction (1,4-alpha-D-Glucosyl)n+n Glucose=n Maltose R0&
Co0277 Compound (1,4-alpha-d-glucosyln HO{CEH10058)Nn 1,4-
RO0183 Reaction AMP+H20=Adenosine+COrthophosphate ROO
RO0185 Reaction ATFP+Adenaosine=ADF+AMP ROO
RO1560 Reaction Adenosine+H20=Inosine+MNH3 RO14
RO1561 Reaction Adenosine+Orthophosphate=Adenine+alpha-D-Ri... RO14
RO1770 Reaction Inosine+H20=Hypoxanthine+D-Ribose RO17
RO1363 Reaction Inosine+0Onhophosphate=Hypoxanthine+alpha-D-... RO1

Co0147 Compound adenine CAHEMNE aden

MNode Attribute Browser | Edge Attribute Browser | Netwark Attribute Browser
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Rearranging attributes in the Data Panel

To reorder attributes in the Data Panel, click an attribute column heading and drag it
to a new location:

Data Panel
B D ﬁ Q:Iick the column ’
D

Description ™ Type

00328 kynurening Compoul
02700 IHormylkynurenine | Compound
C05560 I-2-aminoadipate ad 1t Compound
C04076 I-2-aminoadipate 6-semialdehyde Compound
C02406 formylkynurenine Compound
Coo108 anthranilate Compound
00956 alpha-amino-adipale Compound
C00020 T Losphate Compound
Data Panel{ Drag the column 5
B0

D Descrip . Type | ofelm—
€00328 Fkynurenine Compound b¢
02700 IHormylkynurenine Compound
C05560 I-2-aminoadipate adeny Compound
C04076 I-2-amir 6-sen Compound
02406 formylkynurenine Compound
Coo1o8 anthranilate Compound

C00956 alpha-aming-adipate | Compound
€00020 d - —

295 Brop the column into posn@;
Data Panel_

D Type .
C€00328 C W Lkynurenine

C02700 Compound i

C05560 Compound 2-aminoadipate adenylate
C04076 Compound 2-aminoadipate 6-semialdehyde
€02406 Compound _ jprmylkynurenine

coo108 Compound nthranilate

C00956 Compound Elpna-aminn-adipate

C00020 Compound hdenusma 5-monophosphate

To sort by an attribute, click the attribute column heading; to sort in the reverse
direction, click again.

Data Panel
MO
D Pathway © Type

RO3098 Lysine metabolism ¢ Reaction L-2-Amino
R0O1939 Lysine metabolism Reaction L-2-Amino
RO3103 Lysine metabolism Reaction L-2-Aming
RO3102 Lysine metabolism Reaction L-2-Amino
RO0185 Purine metabolism Reaction ATP+Aden
R0O0133 Purine metabolism Reaction AMP+H20:
RE1233 Tryptophan metabolism Reaction a-ketoglut;
RO1960 Tryptophan metabolism Reaction L-Kynuren

<

Mode Attribute Browser Ege Attribute Bruﬂser_l!letw_k Attribute Browser

S
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NAVIGATING A NETWORK

Navigating among networks

To navigate among multiple open networks, use the Network tab in the Cytoscape
Control Panel.

( Total number of nodes/edges )
&)

Control Panel
fe Metwork | vizMapper™} Edto\| Fiters

Network with no | o W & 4>0024) 473024) Current network
network window

86(0)
274(0)
285(0)

(Number of selected nodesledges)

To view a network, click on its entry on the Network tab.

Note: The default network title is a list of its initial seed compounds. To edit a title,
right-click the network entry and select Edit Network Title.

For more information about working with networks and the Network tab, see the
Cytoscape User Manual.
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Navigating within a network

To navigate within a network, use the network overview pane at the bottom of the
Network tab in the Cytoscape Control Panel.

File Gdi View Salest Lwyswr Phugine Hilp

EEeeue @ = -l @

 Conmy Pangl &1 [L7CPI051 CO02FI CULAFG CORIFL CROISE o [ S

inasina @Mpnam

inosine sn.- ate T.
» R

4
A (1 _-I-alntDS'.

N
mu‘\m.'J\-ileule
Area visible in i
main network

window -
W

1 2 dem-,-aden'dinnnspna[e
ep..sc d,,c_ 2 -cediyaden @ riphosphate

Data Panel

L HOE
Ee——— o |

$

Zoom tools

=

fiode Adtriube Browser | EAge Attribate Browcer | Network Attriute Browser

S p— Tight chck + drag to g »

To view another part of the network, click on the shaded area in the network
overview pane and drag it into place.

To adjust the view magnification, use the Zoom tools in the Cytoscape toolbar:

Q Q

and Zoom In

e Zoom Selected Region . Make one or more selections using any Cytoscape
method, then click this tool to display the region that encompasses all of them.

&

For more information about zooming and using the network overview pane, see the
Cytoscape User Manual.

e Zoom Out

e Zoom Entire Network
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Locating compounds or reactions within a network by
searching

You can locate and select a specific compound or reaction within a network by using
the Search feature of Cytoscape. You can also use search to find a group of
compounds or reactions with common attribute values. Search is especially useful
with large, complex networks.

Limitations of the Search feature in Cytoscape:

e For a successful match, the search term must match the entire attribute value.
For example, the following Enzyme attributes do not match:

— 2.3.1.65 [Bile acid-CoA:amino acid N-acyltransferase.]

— 2.3.1.65 [Bile acid-CoA:amino acid N-acyltransferase.]; 6.2.1.- [Acid--thiol
ligases.]

e For a successful match, the search term must match the attribute value from the
start of the string—you cannot match a substring within an attribute value. For
example, the search term taurine matches the first attribute value below, but
not the second:

— taurine+deoxycholoyl-CoA = CoA+H('+)+3"a",12"a"-dihydroxy-5"b"-cholan-
24-oyl-taurine

—  (5-L-Glutamyl)-peptide+Taurine=Peptide+5-Glutamyl-taurine

e Search does not support logical operators, wildcards, or other advanced search
features.

Note: For more flexible and powerful searching, including logical operators and
wildcards, you can use the Enhanced Search plugin for Cytoscape. For more
information, see the Analysis group of plugins on the Cytoscape Plugins page.

To search for compounds or reactions:

1. Click % (Configure search options) to the right of the Search box in the
Cytoscape toolbar.

Metscape Plugin User Guide - April 2010 - Page 17
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2. Set search options.

1 )

\=:| Configure Search Options for: C00051 C00293 C01496 C...

Search:

@) Nodes () Edges 4—(‘5elect which attributes to IisD

Select Attribute:

. =4 Select the attribute
Inique Identifier -

CAS to search by

Description
Formula =
Mass Vgl
Sead Node

Smile - a
Sample Attribute Values:
bradykinin

malate H

n-acety#d-galactosamin( Click Apply
cysteine
histidine

| cancel || Apply

Note: Attribute options available depend on whether reactions are shown as
nodes or edges. Left-over options may appear in the list if you've switched from
one network style to another during your session.

3. Enter a search term in the Search box. As you type, matching attribute values
appear in a drop-down list.

Search: {:hrhamnyi phnsphi|v E
CO0051 i carbarnoyl phosphate 1 hic |37 CO0294 CO0099 CO0366A
carbon dioxide 1 hiv [
Carnasine 1 hit Y
chenodeoiychaloyl-coa 1 hit 3
_|okdlg e [ Fne
chitin % 1 his 'D“ﬁo? a
% » !chenndenxychnln}rl-cnal | ED;.\}.E
isobudyrylgkycine P,

y
Jadihydro-12RE hydrb xy- leu kotriene E4
=0 A
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4. Select an item in the list to locate the node or edge. Cytoscape zooms to the item
and selects it.

Note: Using Search to select a reaction shown as an edge also selects the
connected compounds; selecting a reaction shown as a node does not.

Search: n(lenxychnloﬁ-cna"u l

C00051C00293 C01496 C00791 00159 CO0212 CO0245 CO0137 CO0294 CO0O099 CO0366 CO0153 CO0299 CO1239 CO0140

chenod loyl-coa

deoxy yI-CoA

Example: Locating reactions on the same pathway (tryptophan metabolism)

1. Select the Pathway attribute for reactions (in this example, shown as nodes).

| £ Configure Search Options for: 00051 C00293 C01496 C... [3

Search:

@ Nodes () Edges

Select Attribute:

Attribute Description:

o description available.

Sample Attribute Values:

Purine metabalism

Methioning and cysteine metabolism
Histidine metabolism

Glycerophospholipid metabolism
Phosphatidylinositol phosphate metabolism
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2. Type in the Search box, select Tryptophan metabolism (with 5 matching
reactions), and press Enter.

Search: |thyptophan metabo v %

00051 Jitryptophan metabolism h 5 mit= 137 €002

"

R

v
t.:’_} R m &
|-alani o
-, q
Cf:l:p):ba'\rf‘ oate

.-"/’

3. The 5 reactions are selected.

Rp1o§*

RO1960

BRE123<a

RD09G7 can

RO 1936
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4. The Data Panel displays attributes for the selected reactions.

Data Panel

=0

Pathway ModeLabel Description
RO1953 Tryptophan metabolism F01953 Formylkynurenine+H20=F
RO1960 Tryptophan metabolism FO1960 L-Kynurenine+Oxygen+MAl
ROO937 Tryptophan metabolism FO0937 L-Kynurenine+H2O=Anthrz
RE1233 Tryptophan metabolism FE1233 a-ketoglutarate+L-kynureni
RO1956 Tryptophan metabolism F01956 L-Kynurenine+2-Cxoglutar:

Locating compounds or reactions using the Data Panel

You can locate compounds and reactions in the network by selecting their attributes

in the Data Panel.

1. Click the Node Attribute Browser or Edge Attribute Browser tab in the Data

Panel.

2. Select attribute rows for the nodes or edges you want to locate.

e Click on a single row to highlight a single compound or reaction.

e Use Ctrl-click to select multiple discontiguous rows.

e Use Shift-click to select a range of contiguous rows.
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3. For selected rows, the corresponding compounds and/or reactions are highlighted
in green in the network view. (See “Selecting Compounds and Reactions.”)

rpostr  rfoal2
RO0862 b i '
I ™ RO1542
F'|:l|}5 13 /4
ks 1
amp= B4
ROCS T '5‘1—
iI:Iir}
F'Ff.'-" :
sn-gh,rceru—.phocholi C
-
RIBIE1T | p
~ RpzEn
Data Panel
=R
Il
] Description Formula ModeLabel
CO0G70 sn-glycero-3-phosphochaline CaH21MOGEP sn-glycera-3-phospho
RO2372 dUTP+Cytidine=dlUDP+CMP RO2372
C00475 cytidine COH13M3045 oytidine
CO00055 cmp COH14M308P CImp
ROD516 UTP+Cytidine=UDF+CMP RO0S16
RO2096 dTTP+Cytidine=dTDP+CMP RO20496
Mode Attribuke Browser | Edae Attribute Browser | Mebworlk Attribute Browser

Metscape Plugin User Guide -

April 2010 - Page 22



FIESREINCIBI

SELECTING COMPOUNDS AND

REACTIONS

Use Cytoscape methods to select nodes representing compounds and reactions
(when shown as nodes) and edges representing reactions (when shown as edges).

Selecting a single compound or
reaction shown as a node

Click the compound or reaction
node.

A selected node appears in yellow.

r il
srghycer &a‘-;‘;phocholine

Selecting a single reaction
shown as an edge

Click and drag a rectangle around R faRE S

any segment of the reaction edge,
then release the left mouse button.

A selected edge appears in red.

-Abosy}H--arginine
r@ ’ v?
1—meth@am\de

i

]

Y

-1 adpcﬁ@cceptur
v, v

-
e
~

b n-ribos@nam\de
n|cat|nam\d@unucleotlde

Selecting multiple compounds
and/or reactions

Hold down the Shift key while
clicking on nodes and/or edges
and/or while dragging rectangles
around them.

. il
srghycer &é-%phocholine

hl
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Selecting compounds and/or Before

reactions within an area

r

trans-4 @ypro\ine

Click and drag a rectangle around il uxim@wm
am{lil“ mino acid a0
«
any area of the network to select the |, »
nodes and edges within that area. P F’fﬁe r
PE&?PDD_:‘E r RE‘
T ‘
f 4
Selecting any part of a node or edge |
selects the entire node or edge. = (S>1-w"°'§"§r§am'a*e
al e
Y
After
,,/'J ‘..-"'
tlans-4—@pr?|line
ma@mmo i ux\dif{{i}minna f/ ;-.
¥ //__.-" I r's /
/// s ‘u' ‘ R@e ’."
i | \ P
RO3 167 S AN | / 1
E R!::Tioﬂ% 1 /’
| [ A P 5
[ / / /!
(ST 4 e
[ / .)_,f v
| s
1 | .‘I / // ; 74
E=8 | ’;/ (s)—1-pyrro$‘e:—5-\§;rbmlate
2
Y

For more information

For detailed information on selecting nodes and edges in a network, see the

Cytoscape User Manual.

FILTERING REACTIONS BY PATHWAY

You can highlight reactions associated with specific pathways, and optionally create a

subnetwork containing only those reactions.

Note: Pathway filtering works only when reacti

Metscape Plugin User Guide -

ons are shown as nodes.
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To filter reactions by pathway:
1. Right-click on any node (compound or reaction).

2. Select MetScape > Pathway Filter to display the MetScape Filter tab in the
Cytoscape Control Panel.

3. Select one or more pathways of interest.

Contral Panel L]

VizMapper™ | Editor | Filters | MetScape Filter| Q]

[] Aminasugars metabalism

[7] Bile acid biosynthesis

[7] Fructose and mannose metabolism

[7] Galactose metabolism

[ Ghycerophosphalipid metabaolism

Glycine, sering, alanine and threonine metabalism
[ Histidine metabalism

[ Isolated

..............................................

[] Lysine metabolism

[] Methionine and cysteine metabolism

Phosphatidylinositol phosphate metabalism

4. Click the Filter button at the bottom of the MetScape Filter tab to highlight
reactions in the network that are in the selected pathways.

All connected edges to matching reactions and compounds are highlighted in red.
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) 1
o | T
rp ¢ [ o,
. ¥ 1 | \“\\:‘\ H"H""\-\._
,'4 | | \‘\\\,\ H'*—n.x
f I e Hﬂﬂa_ .
ST ___.e" | \\\‘\ 4
) ' A
S

!
5. To create a new subnetwork of the original network containing only those
reactions in the selected pathways, click the Create SubNetwork button.

The subnetwork appears as a child of the original network on the Network tab in

the Control Panel.
Control Panel [t5)

s Network | vittapperr | Edtor | rters .| |
Original network etk flocies Eckres < Subnetwork ’
210(0) 274(49)
00122 CO0042 C38{0)

ACCESSING ADDITIONAL COMPOUND AND REACTION
INFORMATION

In addition to viewing compound and reaction attribute values for selected nodes in
the Cytoscape Data Panel (see “Choosing Attributes for Display in the Data Panel”)

and displaying attributes by hovering the mouse cursor (see “MetScape plugin
selection behavior™), you can display additional information and link to external

databases.

Displaying compound and reaction details

To display details about a compound or reaction:

¢ Double-click the compound node, reaction node, or reaction edge.

Details appear on the Node/Edge Details tab in the Cytoscape Results Panel.
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100956 CO0306 C... = |=F [#3= | Results Panel (o)
Mode |Edge Details
C04006 B
F';':"l 187 Compound
[}
Primary Mame:

ld-myo-inositol 3-phosphate

Synenym:
1 d-myu-in@phusphate ld-myo-inositol 3-monophosphate

d-myo-inositol 3-monophosphate

m

d-myo-inositol 3-phosphate

Details beyond the attributes that appear in the Data Panel include:

Compound details: Reaction details:
Results Panel &) Results Panel _ =
[ MetScape Lagend| Node/Edge Detsis | [ MetScape Legend| Node/Edge Detais | i
C00322 RO1958

Compound
Compound synonyms Reaction

Primary Name: Equation:
Links to KEGG Formyllynurenine+tH20=F ormate+L-Kynurenine
enzyme entries

2-oxoadipate

Synonym: Enzyme:

2-oxoadipic acid -3.5.1.49 [Formamidase.]

i -3.5.19 [Arylformamidase.]
F;:ag; - Corresponding genes from MiMI:
5 Links to relqted 125061 [Symbol: AFMID]

genes in MiMI
Mass:

- Pathway:
Links to Tryptophan metabolism

CAS:
3184358 compound Reversiblefy/n]?
entries in Nt
Smile: external
Smile: datab
CCCE0)C(=0)0)CC(=0)0 _ databases, Lins:
including MiMI MiMI [R01953

Links: KEGG [R01958
MM [C00322]

KEGG [C00322
PubChem [71

BioCye 2K-ADIPATE
ChEBI [15753]

HMP [HMDB00225]

Links to reaction
entries in MiMI
and KEGG

KEGG 2D structure:

Ho\nf\/\nj\ — KEGG structure
OH

cooszz

Metscape Plugin User Guide - April 2010 - Page 27



FIESREINCIBI

WORKING WITH NETWORKS

Expanding a network

From a compound node, you can expand the current network to include additional
reactions and related compounds.

Option 1: Expanding a network in the current network window

1. Right-click the compound node you want to expand (the expansion seed
compound).

Original network:

Expansion seed
compound

de@me
»
pseudoun‘hosphate

5,6- I@' racil

2. Select MetScape - Expand - Expand in Current Window. As a result:
e The current network view may be redrawn.

e The expansion seed compound may appear in a different location in the
redrawn network view.

e Additional compounds and reactions are added to the current network.
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e On the Network tab in the Control Panel, the number of nodes and edges in
the network is updated.

Network expanded in the current window:

Compounds in
original network

Expansion seed
compound now
appears here in the
redrawn network

Reactions in
original network

Reactions
added

Compounds

4 added

When you expand a network in the current window, the network view includes
additional symbols, as shown in the MetScape Legend:

Results Panel L]
MetScape Legend

Initial seed compound
Compound

Expansion seed compound
Expansion compound
Feaction

Expansion reaction

Reaction with single or no enzyme

Regction with multiple enzymes
E e T

-"i[IDDD0.0.

=T .
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Option 2: Expanding a network in a new window

1. Right-click the compound node you want to expand (the expansion seed
compound).

Original network:

( Expansion seed )
compound
> 2-ate
v

»
9

D197

Rl
v
RD3103 I- 2—amin adenylate
Va < w=03098
’alpha—‘dipate 1
I-2—aminoadimial yde
R 2

RD310

2. Select MetScape > Expand > Expand in New Window. As a result:
¢ A new network is created in a new network view window.

e The new network includes only the expansion seed compound and its related
compounds and reactions.

e Nodes and edges appear using standard symbols, not expansion symbols.

e On the Network tab in the Control Panel, a new network entry is created.
The default network title is the compound ID of the expansion seed.
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Network expanded in a new window:

Expansion seed
compound

s-glutaryllipoamide

alpha-@ﬂpale "WRD193%« o ate

4

Collapsing a network

To collapse a network expanded in a current network window:
1. Right-click an expansion seed compound node .

2. Select MetScape - Collapse, and then:

e To collapse only the branch expanded from that expansion seed compound,
select Collapse.

e To collapse all expanded branches, select Restore Original Network.

Creating a subnetwork

You can create a subnetwork (child network) of the current network that will appear
in its own network view:

e A subnetwork based on a compound includes the compound and all reactions in
the parent network in which the compound participates.

e A subnetwork based on a reaction includes the reaction and all compounds in the
parent network that participate in the reaction.
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Note: A subnetwork will include any nodes and edges highlighted (nodes in yellow,
edges in red) at the time you create the subnetwork. This includes any nodes or
edges that are currently selected. If you want a subnetwork based on a single
compound or reaction as described above, first clear all selections by clicking any
blank area of the network view.

1. In the network view, select the compound or reaction on which you want to base
the subnetwork. Nodes highlighted in yellow and edges highlighted in red will
become part of the subnetwork.

2. Right-click the node and select MetScape 2> Create Subnetwork. Be careful
not to move the cursor outside the bounds of the gray menu panels while
navigating the cascading menu—doing so will remove the highlighting of the
nodes and edges and the result will be an empty subnetwork.

Correct Incorrect

_— 4 Cursor outside
1 [ |-
REST = RpF* 1 menu
4 | R0O5196 4| R05196
,/' Visual Mapping Bypass ¥ . Visual Mapping Bypas: »
4 [ S WD Sepiee < 1 4-alpliged- cosy = 2
(1 ,4-atp@cusyl_ ( ’{}“
LinkOut 3 LinkOut » B
MetScape v man . MetScape »
Create Subnetwork
Create Subnetwork h

e Edge Label »
Edge Label v By et
Pathway Filter

Show Reactions as Edges
Show Reactions as Edges
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The newly created subnetwork appears in its own network view window, and is
added as a subnetwork (child) of the original (parent) network on the Network
tab in the Control Panel:

Contral Panel ) | 2 C00051 C00293 CO1496--child.6

Te network | VizMapper™ I Editar I Filters|

Metwork Nodes Edges

24(3)
+0)
3(0)
5(0)
15(0)
4(0)
9(0)

C00051 C00293 C4(0)

4
A
R05196

See also “Filtering Reactions by Pathway” for information on creating a subnetwork
from a pathway filter.

Destroying a network
To destroy a network you no longer need:
1. Make sure you want to destroy the network:
e Cytoscape will not ask you to confirm the deletion.

e Destroying the network is irreversible.

e Note: If you want to destroy a network view without destroying the network
itself, use Destroy View instead of Destroy Network. See the Cytoscape
User Manual for more information.

2. On the Network tab in the Control Panel, right-click on the network you want to
destroy (the network does not need to be selected), and select Destroy

Network.

Note: If you destroy a network that has subnetworks, the subnetworks are not
destroyed. They are promoted up one network level.
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VISUALIZING CHANGES IN EXPERIMENTAL DATA
To visualize changes in experimental data:

1. Load a properly formatted experiment file. (See “Load an experiment file.”)

2. Make sure the nodes that are of interest to you are not selected. The color
changes representing changes in data values will not be visible with the selection
color (yellow) applied.

3. Right-click on any node and select MetScape 2 Dynamic Expression to display
the Dynamic Expression dialog:

| £/ Dynamic Expression == ]

Time Series

Expression_1[0,1881 ko 2,9366] Contral Mode Calor
Expression_2[0.8054 ko 296,1351] Contral Node Size
benign_fald_change

U

0 1

%]

Play

I Pause ]
Dismiss

The network display changes to show nodes in variable color and size ranges,
based on the values in your experiment file:

l Play J [ Skop J

Normal display

-

®

Dynamic Expression display

nintgs
L ‘f)ﬂé!
s - L
— aﬂ\ib“\- w0150} @
forr) W
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The color and size ranges in the MetScape legend apply to nodes in Dynamic
Expression:

O | Color range [(255.236,255) to (102.0,0)]

Q—<:> Size range [50 to 250]

The color range shows changes in value for the first parameter in your
experiment file, the size range for the second parameter in your experiment file.

4. To visualize your experiment file data, you can:

Show values of a particular data set by moving the slider (from O to 1 in the
following example):

| £:| Dynarnic Expression F=R|EoH T
Time Series

Expression_1[0.1881 ko 2,9366] Control Mode Calor
Expression_2[0.8054 ko 296,1351] Contral Node Size
Localizedvs_benign_faold_change

(]
0 1 2
Flay

| Play | | Pause | | Skop |

Dismiss

The line of text above the slider also changes to show the current column
heading of data from your experiment file.

You can also play an animation using the Play, Pause, and Stop controls in the
Dynamic Expression dialog. When an animation is playing, the slider in the
Dynamic Expression dialog moves from point to point, and the network view
displays the values at each point, using the appropriate color and size ranges.

5. When you are done, click Dismiss.

SAVING AND REOPENING A SESSION

Saving a session
To save a Cytoscape session containing one or more MetScape plugin networks:
1. Select File > Save (or Save As...) from the Cytoscape menu.

2. Browse to a location for the session file.
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3. Name the file.

4. Click Save.

Reopening a session

To reopen a saved session containing MetScape plugin data:
1. Select File > Open from the Cytoscape menu.

2. Navigate to the file location.
3. Select the file.

4. Click Open.
5

After Cytoscape reports that the session file was successfully loaded, click Close.

USING METSCAPE PLUGIN-SPECIFIC FEATURES IN
CYTOSCAPE

Switching network style for showing reactions

You can switch from showing reactions as nodes to showing them as edges, or vice
versa.

1. Right-click on any node.
2. Select MetScape - Show Reactions as Nodes or Show Reactions as Edges.

The network view is redrawn in the selected style. Switching network style also
affects the attributes available in the Node Attribute Browser and Edge Attribute
Browser.

Labeling reactions shown as edges

When reactions are shown as edges in the network view, you can display their
reaction IDs to identify them.

1. Right-click on any node.

2. Select MetScape - Edge Label - Show Edge Label.
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RO1262

R01262

a
(5-I-glutarg afino acid

3. To hide the IDs, select Hide Edge Label instead.

a
(5-I-glutam arnino acid

Restoring the MetScape visual style

You may need to restore the MetScape visual style after using a different plugin that
uses its own style.

Network after using the MCODE plugin with MCODE visual style
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1. In the Cytoscape Control Panel, click the VizMapper™ tab. You may need to use
the scroll arrows 4| *| at the top of the Control Panel to see the tab.

2. For Current Visual Style, select MetScape:
Contral Panel
%2 Network| VizMapper™ | Editor | Filters | M...

Current Visual Style
:MetScape -

3. The MetScape visual style is restored:
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Network after resetting the MetScape visual style
homocy@lolactone

@ s—adenos»@'[
\

1

nln_di@cmi‘}ﬁ;%ﬁf

Iip@in @
f ‘ A ‘ ¢mahynhi@bmanoate

/ / / \\
\\

\
hY

6 wﬂ%tnmet mmgniobutanal

Accessing the MetScape plugin legend
In the Cytoscape Results Panel, click the MetScape Legend tab. You may need to

use the scroll arrows in the Results Panel to see the tab.
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Results Panel l
MetScape Legend | MCODE Result 1 | MCODE ... | <] »

Initial seed compound

Compound

Expansion seed compound
Expansion compound

Reaction

Expansion reaction

Reaction with single or no enzyme

Reaction with muliiple enzymes

UUdfdoeoe

Monreversible reaction

Reversible reaction

Subsirate compound

Product compound

Substrate and Product compound

Color range [(255.236,255) to (102,0,0)]

Size range [50 to 250]

3

e Reaction symbols in the legend apply to reactions when shown as nodes.

e Color and size range symbols apply to Dynamic Expression displays (see
“Visualizing Changes in Experimental Data”).

Note: If you open a saved Cytoscape session, the MetScape Legend tab does not
appear in the Results Panel until you use the MetScape plugin to enter data in a new

query.
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